
Getting Started
with PowerPoint

The first step of any journey through Microsoft PowerPoint is to start up
the program and either a) create a new presentation or b) open an exist-

ing presentation. Obviously, you can’t do anything in PowerPoint until you
launch the program.

In this chapter, we talk about some methods you can use to launch
PowerPoint and how you can immediately begin to create a new presenta-
tion. We also show you how to save a presentation after you’ve created it
and safely exit the program.

Note that, at this point, we assume you have installed either the entire
Microsoft Office 2003 suite or just Microsoft Office PowerPoint 2003. If you
need to perform an installation, refer to the user documentation accompa-
nying your installer CD for installation instructions.
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Start PowerPoint Using
the Start Menu

1. Start your computer and log on to Windows if your
computer is not on.

2. Choose Start Menu➪Programs➪Microsoft Office➪
Microsoft PowerPoint 2003 (see Figure 1-1). Microsoft
PowerPoint opens, and you’re ready to create a new
slide presentation or open an existing presentation. 

Start PowerPoint Using 
Keyboard Shortcuts

1. Hold the Ctrl key down and press Esc. 

2. Press the P key on your keyboard to select Programs.

3. Press right, left, up, and down arrows to navigate
through the menu commands and folders until you
arrive at Microsoft PowerPoint 2003. 

4. Press Enter to launch PowerPoint (as shown in 
Figure 1-2).

You can also create a program shortcut on your desktop. Locate
Microsoft PowerPoint 2003 on your Start menu and right-click the
PowerPoint application icon to open a context menu. Choose Send
To➪Desktop (create shortcut). The program shortcut is created on
your desktop. Just double-click the shortcut icon and PowerPoint
launches.

Figure 1-1: Open the Start Menu and choose Programs➪Microsoft Office➪
Microsoft PowerPoint 2003

Figure 1-2: Click Microsoft PowerPoint 2003 on the Start menu or select Microsoft
PowerPoint 2003 and press Enter to open the program➟6
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Open a Saved Presentation
1. Launch PowerPoint.

2. Choose File➪Open and the Open dialog box appears
(see Figure 1-3). Alternately, you can press Ctrl+O to
open the Open dialog box.

3. Using the Look In drop-down menu, navigate to your
hard drive and locate the folder where you have a saved 
presentation.

4. Choose List from the View drop-down menu to display
slide presentations in a list.

5. Click a presentation to select it.

If you want to open multiple presentations, press the Ctrl key and
click each presentation you want to open in the Open dialog box.
Click Open and PowerPoint opens all the selected presentations.

6. Click Open and the presentation opens in PowerPoint.

Close a Presentation
1. Open a PowerPoint document in PowerPoint.

2. Click the X in the top-right corner of the PowerPoint
Document window (see Figure 1-4). Be certain to click
the X appearing in the top-right corner of the Document
window. Another X appears at the top-right corner of
the PowerPoint application window. If you click this X,
the program quits.

Alternately, you can choose File➪Close to close the document. After
closing a file, PowerPoint remains open and ready for you to create
a new presentation or open another presentation.

Figure 1-3: Select one or more presentation files in the Open dialog box and 
click Open

Figure 1-4: Click the X in the top-right corner of the Document window or choose File➪
Close to close the open document

➟7
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Create a Blank Presentation
1. Open PowerPoint.

2. Click Getting Started in the Task pane to open a drop-
down menu.

The Task pane at the right side of the PowerPoint window contains
several panes with menus to assist you in creating and editing slide
presentations. If the pane is not visible when you open PowerPoint
or you accidentally lose the pane, choose View➪Task Pane or press
Ctrl+F1. If you need more room to view your slides, you can close
the pane by clicking the X in the top-right corner of the pane.

3. Select New Presentation from the menu (see Figure 1-5).

By default, PowerPoint opens a new blank presentation document
when you launch the program. If you want to begin working on a new
presentation, you can start with the document appearing on program
launch. You can also use any of these options to create a new blank
document: click Getting Started and select New Presentation, choose
File➪New, click the New button on the toolbar, or press Ctrl+N. You
can use any of these options to create a new blank document. 

4. In the New Presentation task pane (see Figure 1-6), select
one of the following options to create a presentation:

• Blank Presentation: Create a new blank presentation.

• From Design Template: Use one of the many design
templates installed with PowerPoint.

• From AutoContent Wizard: The AutoContent Wizard
helps you with presentation ideas. 

• From Existing Presentation: Open an existing pres-
entation you want to modify.

• Photo Album: Create a slideshow of pictures.

5. To create a blank presentation, click the Blank
Presentation option in the New Presentation Task pane.

Figure 1-5: Select New Presentation from the Getting Started drop-down menu

Figure 1-6: Click Blank Presentation 
in the New Presentation Task pane 
to create a new blank presentation➟8
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Create a Presentation Based
on a Template

1. Open PowerPoint.

2. Click Getting Started in the Task pane to open the drop-
down menu.

3. Select New Presentation.

4. Click From Design Template to open the Slide Design
task pane (see Figure 1-7).

5. Scroll the Slide Design Task pane by dragging the slider
on the right side of the pane up and down to view all
templates. You have slides organized into three separate
categories in the Slide Design pane. The categories
include

Used in this Presentation: Any design templates
used in the open PowerPoint document appear in
this category.

Recently Used: Templates you have used in recent
PowerPoint projects conveniently appear in this 
category.

Available for Use: This category contains all the
design templates available to you for creating new
presentations. 

6. Select the template you want to use in a new presenta-
tion from the Available for Use category (as shown in
Figure 1-8).

Note that the template you select in the Slide Design Task pane shows
you a view of the opening slide called the title slide. The title slide
design is usually different from the presentation slides. When you
add additional slides to your presentation, the slide design used for
the presentation slides is similar to the title slide but not identical.

Figure 1-7: Click From Design Template in the New 
Presentation Task pane to open the Slide Design Task pane

Figure 1-8: Click a slide template in the Slide Design Task pane ➟9
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Create a Presentation Using the
AutoContent Wizard

1. In PowerPoint, click Getting Started to open the drop-
down menu.

2. Select New Presentation from the menu.

3. Click From AutoContent Wizard.

4. The AutoContent Wizard opens. In the opening pane,
click Next and you arrive at the second pane (see
Figure 1-9).

5. Click a category from one of the following:

• All: Lists all slide presentations in all categories. You
can scroll the window and select a slide presentation
to create from the list.

• General: Displays a list of general business topics.

• Corporate: Displays a list of corporate topics such as
business plans, financial reports, employee orienta-
tion, and so on.

• Projects: Lists presentations that might be used in a
planning process.

• Sales/Marketing: Lists presentations suited for a mar-
keting program.

6. Click a presentation from within a category and click
Next to move to the next pane (see Figure 1-10).

7. Select an output option from one of the following:

• On-Screen Presentation: Click this radio button to
create a presentation that is intended to be shown on
your computer or on a projector connected to your
computer.

Figure 1-9: Open the AutoContent Wizard and click the Next button 
to arrive at the second pane

Figure 1-10: Click Next to move to the next pane in the wizard

➟10
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• Web Presentation: Click this radio button for a slide
presentation that you want to show on a Web site.

• Black and White Overheads: Click this radio button
if you want to print your slides on clear acetate on a
black-and-white laser printer.

• Color Overheads: Click this radio button if you want
to print your slides on clear acetate on a color printer.

• 35mm Slides: Click this radio button if you want to
print your slides on a commercial film recorder that
outputs to 35mm slides.

8. Click Next to advance to the next pane (see Figure 1-11).

9. Type a title for your presentation in the Presentation
Title text box.

10. Type a footer in the Footer text box if you want a footer
to appear on your slides.

By default, the date of the last update and the slide numbers will
appear on the new presentation. If you don’t want such information
to appear on the slides, uncheck the respective check box in the 
wizard.

11. Click Next in the wizard to advance to the last pane in
the wizard.

12. Click Finish to complete the slide creation and open it
in PowerPoint (see Figure 1-12).

13. Edit the presentation to customize it for your own needs. 

The slide presentation opens in Normal view with the Outline tab in
view. You can edit text in the Outline tab or directly on each slide to
change text and customize the presentation for your own use.

Figure 1-11: Click Next to open the next pane in the wizard, where 
you type a name for your presentation

Figure 1-12: Click Finish in the wizard and the new presentation opens in PowerPoint

➟11
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Change the Opening Default View
1. Open PowerPoint and choose Tools➪Options.

2. Click the View tab in the Options dialog box (see
Figure 1-13).

3. Uncheck the Startup Task Pane option.

When you remove the check mark for the Startup task pane,
PowerPoint opens with the Task pane closed and provides you more
viewing and editing room when working on slides. Press Ctrl+F1 to
show the Task pane. 

4. Review other options on the View tab. You can make
choices for items to remain in view or toggle off the
views for the Show and Slide Show options.

5. Select the option you want to see when you launch
PowerPoint from the Default View drop-down menu. The
default option is The View Saved in the File, which shows
you the last view when you saved your file in PowerPoint.

Change Save Options
1. Open PowerPoint and choose Tools➪Options.

2. Click the Save tab in the Options dialog box (see
Figure 1-14).

3. Type a default directory path — pointing to the place
where you want PowerPoint to save your presentation
files — into the Default File Location text box. The
default folder is My Documents.

4. Click OK in the Options dialog box.

Figure 1-13: Remove the Startup task pane check mark to 
provide more viewing and editing room when working on slides

Figure 1-14: Typing in a new directory path for 
where you want to save your PowerPoint slides

Look over other options on the Save tab and adjust settings according to
your personal needs. Click each tab in the Options dialog box and you can
customize PowerPoint to suit your personal work habits. When you need
information on given settings in the tabs, consult the PowerPoint Help doc-
ument (choose Help➪Microsoft Office PowerPoint Help).➟12
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Save a Presentation
1. Create a new blank presentation or a presentation from

a design template.

2. Open the File menu and select one of the following:

• Save As: Use this option or choose File➪Save when
saving for the first time to open the Save/Save As dia-
log box (see Figure 1-15).

• Save as Web Page: Use this command to save the
design you create in PowerPoint as a Web page.

3. Name your file by typing a name in the File Name text
box and locate a folder where you want to save the file.

4. Click Save to save the file.

Exit PowerPoint
1. Click the Close box in an open presentation document.

2. If you haven’t saved the file since your last edit,
PowerPoint prompts you with a dialog box to save your
changes before the file closes (see Figure 1-16).

3. Click Yes to save your last edits. Click No to exit
PowerPoint if you want to quit without saving your
changes.

Alternately, you can press Alt+F4 to exit PowerPoint.

Figure 1-15: Choose File➪Save As to save a PowerPoint presentation

Figure 1-16: Click Yes to save your last edits before 
exiting PowerPoint or No to ignore edits made since 
the last save
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